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Preface 

Intended Audience 
The Echo Cherry Pick program is designed for use by laboratory personnel. This software 
application assists the researcher by automating individual sample transfer.  

Software Requirements 
To use the Echo Cherry Pick application, you must meet the following requirements: 

 Echo 5XX Liquid Handler system using software version 2.1 or later. 

 License key from Labcyte Inc. 

 Computer system meeting the following requirements: 

Operating system: Microsoft® Windows® XP SP2 or later; .Net Framework 2.0 

CPU: Intel® Pentium® 4 or later (2GHz or greater) 

Memory: 512 MB or higher 

Network connection: 10/100/1000 BaseT 

Network protocol: TCP/IP 

Hard drive storage: 200 MB 

Video: 1024 X 768 resolution, 256 colors or better 

The Echo Cherry Pick application works closely with the Echo 5XX client software and 
should be installed on the same client PC.  
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Manual Organization 
This manual is provided on CD and accompanies the Echo Cherry Pick installation CDs. 
Software procedures and screen descriptions in this manual are also available in the Help 
section of the Echo Cherry Pick application.  

The Echo Cherry Pick user manual is organized as follows: 

Chapter 1, Introduction 

Chapter 2, Getting Started 

Chapter 3, Software Overview 

Chapter 4, Software Reference 

 

Manual Convention 
Some of the text in this manual uses special formatting to indicate emphasis or keystrokes. 
The text conventions are described below: 

Convention Example Meaning 

Bold text Press the Next button. 
Indicates an on-screen button, 

label, menu title, or menu item. 

Courier client.txt, 
client.old2.txt

Indicates a display output, printed 
output, keyboard input, or file 

name. 

Italic, underlined 
Software installation 

Signifies an internet link. 

Quotation marks See “Set up Preferences” on 
page 14. 

Refers you to a topic elsewhere in 
the manual. Usually includes a 

hyperlink. 
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1 Introduction 

The Echo Cherry Pick software offers significant flexibility in transferring nanoliter volumes 
of compound from any well position on a microplate to another microplate. With this 
program you can transfer compounds from several plates to a single plate—or transfer 
compound from a single plate to multiple plates.  

 

 

   
Figure  1-1:  Compounds and controls from multiple source plates to single destination plate 

 

The Echo Cherry Pick software uses the pick list that you create to automate the transfer of 
compound from selected wells. You can transfer point-to-point (from B3 source well to B3 
destination well) or allow the software to fit compounds onto a plate. The program keeps 
track of the transfer process and reports final well positions in customizable reports.  
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1.1 What is a Pick List? 
The pick list is a table of specific compounds that have been selected from a group of 
compounds for analysis. The pick list is typically created in a text or spreadsheet file.  

Note:  Pick lists must be in csv (comma-separated value) format to be used by the 
Echo Cherry Pick software. 

Figure  1-2 is a simple pick list that lists source plate ID, source well ID, and volume to be 
transferred. The location of each compound on the destination plate is determined by the 
software and placed in the next available empty well.  

 
Figure  1-2:  Pick list sample #1 
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Figure  1-3 shows a pick list that specifies well location (row and column) instead of 
well ID. It also explicitly states the destination well location. The Echo Cherry Pick software 
can accommodate many types of pick lists. 

 
Figure  1-3:  Pick list sample #2 
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1.2 What are the benefits? 
The Labcyte Echo Cherry Pick software works seamlessly with the Echo Liquid Handler and 
provides the following benefits: 

Fast 
 Saves time by efficient transfer 

 Executes superior data management 

 Maintains survey history 

 

Flexible 
 Uses pick lists to define well locations and volumes for transfer 

 Customizes reports to match your informatics infrastructure 

 Generates output files in XML, CSV, and TXT format 

 Transfer from 384- or 1536-well Echo qualified source plates to 96-, 384-, 1536-, 
or 3456-well assay plates 

 Allows the output files to be run specific or destination plate specific 

 

Accurate 
 Automates manual steps 

 Removes washing steps and cross contaminations 

 



 

Echo Cherry Pick User Manual  7 

1.3 Documentation 
In addition to this manual, the Echo Cherry Pick software comes with the following useful 
documents:  

 Online Help 

 Quick Start Guide 

Online Help 
Online Help is available in the Echo Cherry Pick software. It contains screen descriptions 
and procedures.  

You can view online Help by using one of the following methods in the software: 

 Click the Help icon  or Help menu in the software toolbar to view the 
complete Help file. 

 
Figure  1-4:  Access to Help from the Toolbar 

 Click the Help icon  in the upper right corner of individual software screens to 
view the Help page for that screen. 

 
Figure  1-5:  Access to Help from the software screen 

 Press the Help (F1) key on the computer keyboard to view the Help page for the 
displayed screen. 
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Quick Start Guide 
The Echo Cherry Pick Quick Start Guide describes the capabilities of the Echo Cherry Pick 
software and takes you through a sample protocol.  

 
Figure  1-6:  Quick Start Guide 

The Quick Start Guide can be found in the Echo Cherry Pick directory. You will need Adobe 
Acrobat Reader to open this document. 

 
Figure  1-7:   Location of Quick Start Guide 
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2 Getting Started 

This chapter describes the basic tasks to start, set up, and finally exit the software.  

2.1 Start the Software  
To start the Echo Cherry Pick software: 

1. Open the Start menu.  

2. Select All Programs (or Programs) -> Labcyte -> Echo Cherry Pick. 

3. Select the Echo Cherry Pick program. 

 
Figure  2-1:  Location of Echo Cherry Pick application 

Hint: To create a shortcut to the Echo Cherry Pick software on your computer 
desktop, press and hold the Control key while you drag the Echo Cherry Pick icon  
to the desktop. 

The software begins with the Connect to Instrument screen.  

s 

Figure  2-2:  Connect to instrument screen 

You can connect to the instrument at this time or work offline and connect when you 
are ready to run the protocol.  

Note:  If you do not see an instrument in the Instrument field, the instrument is not 
yet activated for the software. Even if an instrument appears in the Instrument field, if 
you recently installed or upgraded the software, you will need to activate the 
instrument. Go to Activate the Instrument on page 11.  
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4. Select one of the following start options: 

Connect:  Select an Echo liquid handler from the Instrument menu and click Connect. 
The Main Window opens with the connection status instrument information at the 
bottom of the screen. This option enables you to execute the compound transfer as 
soon as the transfer protocol is ready.  

 
Figure  2-3:  Echo Cherry Pick software connected to Echo liquid handler 

Work Offline:  Click Work Offline. The Main Window opens with the connection 
status “offline” at the bottom of the screen. This option enables you to create a 
transfer protocol and run the transfer simulation without connecting to the Echo liquid 
handler. 

 
Figure  2-4:  Echo Cherry Pick software offline 
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2.2 Activate the Instrument 
To run the Echo Cherry Pick software on an Echo liquid handler, you will need to activate 
the instrument with a software license key from Labcyte.  

 If you purchased the Echo liquid handler and Echo Cherry Pick software at the same 
time, your instrument will be delivered with the key pre-installed. You can skip this 
activation section. 

 If you purchased the Echo Cherry Pick software separately or upgraded the software, 
then you will have to perform this task. 

To activate the instrument:  

1. Start the Echo Cherry Pick software.  

2. In the Connect to Instrument screen, click the Work Offline button.  

 
Figure  2-5:  Connect to instrument 

3. Click the Tools tab in the Toolbar and select the 
Activate Instrument option.  

4. Enter the IP address of the Echo server.  

5. Enter the license key. The license key is an 
encrypted block of text that authorizes the user to 
run the Echo Cherry Pick software with a specific Echo liquid handler.  

You can insert the license key in one of the following ways: 

 Copy the license key from the file you received from Labcyte and paste it into the 
License Key text box. 

 Click the Open License Key File button and browse for the license key file.  
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Figure  2-6:  Activate instrument screen 

Note:  The Get Current Key function is a useful troubleshooting tool to verify that 
the key is written correctly to the instrument. When you click the Get Current Key 
button, the software will search for the license key and insert it into the License Key 
text box. Send the encrypted key to Labcyte to determine if the license key is corrupted 
or if it applies to a different instrument. 

6. Click the Activate button. 

 

The Echo liquid handler is now activated. You will not have to perform this procedure 
again unless you need to activate a different instrument or upgrade the software.  
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2.3 Main Window 
When you open a new or existing protocol, the Main Window displays the Protocol 
window.  
 

 
Figure  2-7:  Main Window 

Screen Components 
The components in the Main Window are described below. 
 

Toolbar:  The toolbar contains software menus that provide access to functions to open 
and save transfer protocols, set up the software, define labware, run the protocol, 
customize protocol options, and display the online Help. The icons in the toolbar provide 
shortcuts to the most frequently-used functions, such as the Run Protocol function. For a 
detailed description, see “Toolbar” on page 43. 

Protocol file name: The protocol file name identifies your transfer protocol in the 
computer’s directory. The software uses an “.ecp” file extension and stores the file in the 
default directory:  C:\Labcyte\Echo\Protocols. You can store your protocols in 
different directories. 

Status Bar 

Toolbar 

Protocol 
File Name 

Protocol 
Window 

Navigation and Exit buttons 
Window 

Tabs 
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Window tabs:  The window tabs open the following software windows: 

 Protocol window: The Protocol window is the first window that is displayed when 
you open a new or existing protocol. It contains all of the default protocol data 
necessary to perform the transfer. For a detailed description, see “Protocol“ on 
page 44. 

 Pick list window:  The Pick list window contains functions to import, edit, preview, 
and save pick lists. These functions are organized in the following windows: 

 Compounds:  compound pick lists that represent unique compounds on one or 
more plates. 

 Controls:  control pick lists that represent control compounds that are added to 
every plate. Controls are optional. If control pick lists are not imported, the 
software ignores the control settings in the protocol.  

 Plate Preview:  To display plate layout for source and destination plates. 

For a detailed description of the windows, see “Pick List“ on page 51. 

 Options window:  The Options window (behind the Plate Design window) displays 
protocol-specific options, such as survey history, output file type, and report formats. 
For a detailed description, see “Protocol Options“ on page 56.  

Status bar: The status bar displays Echo connection information, such as instrument 
name and serial number, and the version of Echo client software that is running.  

Navigation and Exit buttons: The left and right arrow heads ( ) become active 
when you have too many protocols open to view all of the file names. The arrows shift 
the protocol tabs left or right to display the file names. The Exit icon ( ) closes the 
displayed protocol. 
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2.4 Set Up the Software 
Your Echo Cherry Pick software needs very little setup. It comes with default settings, such 
as output file type and report format, that can be used. The Echo Cherry Pick software 
provides transfer data in three file formats (csv, xml, and txt) with reporting options that 
can be customized to meet your needs.  

If you want to change these settings, refer to the procedures in this section; otherwise 
continue to the next section, “Software Overview“, on page 17. 

To set up preferences: 

1. Open the Tools menu and select Preferences.  

 
Figure  2-8:  Preferences/Options screen 

2. Select Maintain survey history if you want to re-use the current plate survey for 
more than one transfer operation for a specified period of time. Go to “Survey 
History“ on page 57 for information about this feature. 
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3. Select Run-specific or Plate-specific output files.  

 Run-specific:  Store all protocol data in one file.  

 Plate-specific:  Store the protocol data in separate files, based on source or 
destination plates (depending on which process order you specified in the Plate 
Design window 

4. Customize transfer and survey reports:  

 File type:  Select XML, CSV, and/or TXT file formats. 

 Format:  Customize the transfer report header, body, and footer. 

 Directory:  Change the directory location for the transfer report. 

 Filename:  Change the file name for the transfer report 

These options will be used as default settings for all transfer protocols. If you want to 
change the options for an individual protocol, use the Options tab. See “Preferences“ 
on page 64 for more information. 

 

2.5 Shut Down the Software 
You can exit the Echo Cherry Pick software in the following ways:  

 Open the File menu and select Exit.  

 
Figure  2-9:  Exit function in the File menu 

 

 Click the Close icon in the software window. 

 
Figure  2-10:  Close Window icon 
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3 Software Overview 

The best way to describe the features of the Echo Cherry Pick software is to take you 
through the steps to create and execute a transfer protocol.  

What is a transfer protocol?  
In the Echo Cherry Pick software, the transfer protocol is a set of default parameters that 
provides the Echo liquid handler all the information needed to set up a run.  The only 
information needed at runtime is the pick lists.   

The software automatically creates the optimal transfer sequence that is sent to the Echo 
liquid handler to execute the direct compound transfer to assay plates.   

After the transfer is complete, you can retrieve custom reports that document the transfer 
run and provide well data for sample tracking. 

Sample transfer protocol 
The sample transfer protocol in this chapter uses only three compounds to illustrate a 
simple compound transfer.  

Throughout this overview, there will be references to specific topics in the Software 
Reference chapter, beginning on page 42, which can provide additional details.   

The steps to creating and executing a transfer are listed below: 

1. Create pick lists: created by the user to list specific compound from one or more 
plates to be transferred.  

2. Set up the Transfer Protocol:  created by the user in the Echo Cherry Pick 
software. 

3. Import Compound and Control pick lists:  performed by the user in the Echo 
Cherry Pick software. 

4. Set Up Plates:  performed by the user before running the protocol. 

5. Specify the order of transferring compound:  performed by the Echo Cherry Pick 
software and Echo 5XX liquid handler. 

6. Run the Protocol: performed by the Echo Cherry Pick software and Echo 5XX liquid 
handler. 

7. Manage Transfer Data:  generated by the Echo Cherry Pick software, based on user 
settings.  

Each step contains screen descriptions and procedures. By the end of this section, you will 
have a good basic understanding of the Echo Cherry Pick software. 
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3.1 Create Pick Lists 
The Echo Cherry Pick software can use pick list formats that range from basic pick lists 
that contain only source plate ID and well locations, to more specific pick lists that also 
contain destination plate ID, destination well locations, and transfer volumes. Pick list 
options are shown in the Import Compound List screen (see Figure  3-1) 

 
Figure  3-1:  Import Compound List 

Use the following guidelines to create pick lists that will work seamlessly in the Echo 
Cherry Pick software. 

 Pick list guidelines: 
 Pick lists using row and column location must use the one-based coordinate system, 

which means that the first well in the upper left corner of the microplate is labeled 
row 1, column 1, or (1,1).  

 Well IDs should be in uppercase letters and should not have a leading zero.  
For example:  A1 not A01. 

 Pick list format must match one of the formats listed in the Import Compound List 
screen. 

 Pick list must be saved in csv file format.* 

 

The following sections describe the pick list formats and requirements in more detail. 

                                                   
* csv = Comma separated values, typically in spreadsheet files. 
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3.1.2 Pick List Formats 
The pick list format identifies the data content and layout in the pick list. This information 
tells the Echo liquid handler how to process the compound transfer.  

The Pick List Format window displays all of the supported formats.  

 

 

 
Figure  3-2:  Pick list formats in Import Compound List screen 

 

 Next available well format:  The top four formats use the Next available well 
format. This format specifies the source well locations and allows the Echo liquid 
handler to fill compound into consecutive, available, destination wells.  

Source Plate 
Barcode

Source 
Well

Plate1 D5
Plate1 B6
Plate1 J7
Plate1 C10
Plate1 O16    

Figure  3-3: Pick lists using next available well format 

For example, it can be used when consolidating compounds from different source 
plates onto fewer destination plates, or replicating compounds over several 
destination plates. This method of filling the destination plates allows you to maximize 
plate space and randomize the placement of compounds. The pick list is also easier to 
design. 

Protocol options, such as reserved wells, number of replicates, same or different 
plates, and fill direction are used to format the destination plates. 

Source Plate 
Barcode

Source 
Row 

Source 
Column 

Plate1 4 5 
Plate1 2 6 
Plate1 10 7 
Plate1 3 10 
Plate1 15 16 

Next available 
well format 

Explicit 
format 

Well location Row, column location 
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 Explicit format:  The bottom four formats in the Pick List Format window use the 
Explicit format. This format specifies both source and destination well locations.  

Source Plate 
Barcode

Source 
Well

Destination Plate 
Barcode

Destination 
Well

Plate1 D5 destPlate100 A2
Plate1 B6 destPlate100 A3
Plate1 J7 destPlate100 A4
Plate1 C10 destPlate100 A5
Plate1 O16 destPlate100 A6   

Source Plate 
Barcode 

Source 
Row 

Source 
Column 

Destination 
Plate Barcode

Destination 
Row 

Destination 
Column 

Plate1 4 5 destPlate100 1 1 
Plate1 2 6 destPlate100 1 2 
Plate1 10 7 destPlate100 1 3 
Plate1 3 10 destPlate100 1 4 
Plate1 15 16 destPlate100 1 5 

Figure  3-4: Pick lists using explicit format 

For example, it can be used if you need complete control over the placement of 
compounds and controls on the destination plate. This method of filling the 
destination plates allows you to vary transfer volumes or adhere to a particular 
destination plate design.  

Since this format explicitly states the destination well location, it overrides the protocol 
options:  reserved wells, replicates and fill direction. If the pick list includes transfer 
volume, then it also overrides the transfer volume in the protocol. 

 Well location:  The formats in the left column use standard microplate labeling to 
identify well location.  
For example, the first well in the upper left corner of the microplate is A1, the second 
well in the same row is A2, and so on.  

 Row and column location: The formats in the right column use row and column 
location. The Echo Cherry Pick software uses a one-based, row and column coordinate 
system to identify well location; for example, the first well in the upper left corner of 
the microplate is row 1, col 1, also shown as (1,1), the second well in the same row is 
(1,2), and so on. 
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The following table shows all of the supported pick list formats with sample data.  

Table 1:  Pick list formats 

Format 
Source 
Plate 

Barcode*

Source 
Well or   

(Row, Col) 

Destination 
Plate 

Barcode* 

Destination 
Well or  

(Row, Col) 
Transfer  
Volume** 

Transfer 
Location 

Source plate, 
Source well or (row, col) Plate 1 A1 or (1.1)  *** *** 

Next 
available 

well 

Source plate, 
Source well or (row, col),  
Volume 

H5412 B4 or (2,4)  *** 5 
Next 

available 
well 

Source plate,  
Source well or (row, col), 
Destination plate,  
Destination well or (row, col)

Plate 5 G3 or  
(7, 3) 

destPlate10
0 

C2 or (3, 
2) *** Explicit 

Source plate,  
Source well or (row, col), 
Destination plate,  
Destination well or (row, 
col), Volume 

54654 C4 or (3,4) 39786 H6 or (8,6) 2.5 Explicit 

    *Source and destination plate fields can contain barcode data or plate ID. 
  **Transfer volume that is specified in the pick list. 
***Uses values specified in the protocol. 
 
The Echo Cherry Pick software is installed with three sample pick lists in the default 
directory:  C:\Labcyte\Echo\Protocols. The samples are described below:  

384-384_NextAvailableWell.csv: This is the simplest pick list and matches the first 
format in the Pick List Formats table (see table above). It specifies the source well barcode 
and location. It uses the Protocol settings to determine the number of replicates, transfer 
volume, and filling order. See the following figure. 

Source Plate 
Barcode

Source 
Well

Plate1 D5
Plate1 B6
Plate1 J7
Plate1 C10
Plate1 O16
Plate1 F18
Plate1 I18
Plate1 J19
Plate1 G20
Plate1 B21
Plate3 N5  

Figure  3-5:  Pick list example, Next Available Well 
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384-384_Explicit.csv: This pick list is very explicit in specifying well locations, 
destination plate ID, and transfer volume. It matches the last format in the Pick List 
Formats table (see table on previous page). The information in this pick list overrides the 
protocol settings:  any reserved wells in destination plate design, replicate data (must be 
set to 1), and fill direction. See the following figure. 

Source 
Plate 

Barcode 
Source 

Well 
Destination 

Plate Barcode 
Destination 

Well 
Transfer 
Volume 

Plate1 D5 destPlate100 A2 100 
Plate1 B6 destPlate100 A2 90 
Plate1 J7 destPlate100 A4 80 
Plate1 C10 destPlate100 A5 70 
Plate1 O16 destPlate100 A6 60 
Plate1 F18 destPlate100 A7 50 
Plate1 I18 destPlate100 A8 40 
Plate1 J19 destPlate100 A9 30 
Plate1 G20 destPlate100 A10 20 
Plate1 B21 destPlate100 A11 10 
Plate3 N5 destPlate100 B1 100 
Plate3 L6 destPlate100 B2 90 
Plate3 O7 destPlate100 B3 80 
Plate3 C9 destPlate100 B4 70 
Plate3 D12 destPlate100 B5 60 
Plate3 D16 destPlate100 B6 50 
Plate3 E19 destPlate100 B7 40  

Figure  3-6:  Pick list example, Explicit 

384_Controls.csv: This pick list also matches the last format in the Pick List Formats (see 
table on previous page). It specifies the source plate barcodes, source and destination well 
locations, and transfer volume. It also specifies the number of replicates, transfer volume, 
and filling order. See Figure  3-7. 

Source Plate 
Barcode

Source 
Well

Destination 
Well

Transfer 
Volume

Ctrl1 A1 A1 50
Ctrl1 A2 A24 100
Ctrl1 A3 P1 150
Ctrl1 A4 P24 200  
Figure  3-7:  Control Pick list example, Explicit 

Note:  Control pick lists always use the explicit format, the destination wells must be 
defined; therefore, they use a different pick list format window: 
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3.1.3 Pick List Header Data 
The Echo Cherry Pick software recognizes the following column headings: 

Source Plate Barcode 

Source Well (or Source Row, Source Column) 

Destination Plate Barcode 

Destination Well (or Destination Row, Destination Column) 

Transfer Volume 

Use these column headings in your pick lists. When you import the pick list during protocol 
creation, the software will recognize the headings and display the Import Compound List 
window with the correct pick list automatically selected. The option Data Contains a 
Header Line is also automatically selected. 

 
 

If you choose not to use these column headings, be sure to format the pick list data to 
match one of the pick list formats, particularly the column order; otherwise, the software 
will not know how to process the transfer data. See Figure  3-8. 

 
Figure  3-8:  Pick List format 4b without header line. 
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When you import the pick list without header line, the software will prompt you to select 
the matching plate list format. 

 
Figure  3-9:  Import pick list error 

 Skip First Lines 
Your pick list can contain heading data (for example, assay information, date, etc.), but it 
should be skipped when you import it.  

You can use the option Skip First Lines in the Import Compound List screen to skip all 
heading lines except for the column headings (header line). The preview box Top Rows – 
Compound List File shows the heading data in the imported pick list. The software 
updates the data in the preview box as you skip header lines.  

   
Figure  3-10:  Pick list with additional header lines 
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 Data Contains a Header Line 
If your pick list contains a header line (column headings), select this option. Also, select 
the correct pick list format (the software makes a best guess). See the right screen in 
Figure  3-10.  

   
Figure  3-11:  Pick list with header line and corrected format selection 

 

3.1.4 Pick list file format 
When your pick list is complete, save it in CSV (comma separated values) file format.  

In your spreadsheet program, look for the Save as menu and select CSV (comma 
delimited) (*.csv). This is the file format that the Echo Cherry Pick software recognizes 
when you import pick lists.  

 
Figure  3-12:  Saving to .csv file format 
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3.2 Set up the Transfer Protocol 
The Echo Cherry Pick software is very flexible. It enables you to pick compounds from any 
well position in your source plate and transfer them any well position in your final assay 
plates. You can transfer from 384- or 1536-well Echo qualified source plates to 96-, 384-, 
1536-, or 3456-well assay plates. 

 To create a transfer protocol: 
1. Click the new protocol icon  in the toolbar at the top of the screen,  

or select New from the File menu to open a new Protocol template.  

The new protocol template opens in the Main Window. 

 
Figure  3-13:  New protocol 

The new protocol is temporarily labeled “Protocol 1” until you save it.  

2. Select Save from the File menu and enter a file name in the prompt box. The protocol 
is saved with the file extension “.ecp” in the default directory 
C:\Labcyte\Echo\Protocols. You can save the file to different directories. 

As you enter information in the template, an asterisk 
appears next to the file name. This is a reminder that the 
file has information that has not been saved. Save the 
protocol periodically as you work on it.  

Note:  The saved protocol does not retain imported pick lists, since they are not valid 
across transfer runs. 

Protocol 
Window 

New Protocol 
Template 
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3. Select a source plate type for compounds and controls (optional) from the drop-down 
menu. Enter the compound and control transfer volumes. These transfer volumes will 
be used if the pick list does not specify transfer volumes. 

 
Figure  3-14:  Source and Control Plate Definitions 

4. If you are using controls, choose one of the following options for the time to add 
controls to your destination plates.  

 
Figure  3-15:  Control processing order 

 Select At the end of the run if you want to process all pick list plates first (for 
example, to minimize the time that the plates are out of storage). 

 Select At the end of each destination plate if you want to add controls to 
each destination plate, but also need to process the destination plate as soon as 
possible (for example, to transport the plate to a controlled environment).  

5. Select a destination plate type from the drop-down menu.  

6. If reserve wells are needed, select wells in the destination plate map and click the 
Reserve button. The software will skip over the reserved wells during compound 
transfer. 

 
Figure  3-16:  Reserved Wells 
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Note:  Reserved wells will be ignored if the destination wells are defined in the pick 
list (Explicit format). See description of Explicit format on page 20. 

7. Enter the information in the Next Available Well Mode box: 

 
 Specify the number of replicates for each compound well.  

 Specify whether the replicates must be in the same plate or in different plates. 
If the replicates are in the same plate, you can select the option to place the 
replicates In Adjacent Wells.  

 Specify the fill direction on the destination plate.  

Notes:   

– Settings for the Next Available Well Mode apply only when the destination wells 
are not defined in the pick list.  

– If the imported compound pick list has destination wells defined (Explicit format), 
then the number of replicates must be set to 1; otherwise, the software will 
display a message that prompts you to reset the replicate number. The other 
settings in the Next Available Well Mode box will be ignored. 

See "Create Pick Lists“ on page18 for information on Next Available Well and Explicit 
pick list formats. 
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3.3 Import Compound and Control pick lists 
You can import compound and control pick lists from the Pick List window or from the Run 
Options window. The Pick List window gives you options to edit the pick list and preview 
the plate maps.  

1. Open the Pick list window. Click the Pick list tab to display the import and 
editing windows for compound and control pick lists. 

 
Figure  3-17:  Pick list windows 

Three windows are available in the Pick List window: 

 Compounds window— provides an import button and text box to import, edit, 
save, or delete the compound pick list. 

 Controls window — provides an import button and text box to import, edit, 
save, or delete the control pick list. 

 Plate Preview window — displays source and destination plate layouts that 
are based on the imported pick lists and protocol settings. 
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2. Import the compounds pick list. 

a. Click the Import button in the Compounds window.  

b. Browse to the folder that contains the compound pick list and open the pick list 
you want to import. 

 
Figure  3-18:  Select pick list 

 If the pick list contains the column headings that the software recognizes 
(see Pick List Header Data“ on page 23), the software displays the Import 
Compound List window with the correct pick list format selected. Continue to 
step c. 

 If the pick list contains extra header lines, no header lines, or header lines that 
the software does not recognize, the software displays an error message. 
See Figure  3-19.  

Click Yes to continue to the Import Compound List window. 

 
Figure  3-19:  Import pick list error message 
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c. In the Import Compound List window, select the format that matches the pick list 
you are importing, if it is not already selected.  

 
Figure  3-20:  Select compound pick list format 

d. Specify the number of lines to skip if the pick list contains other header data. 
See “Skip First Lines“ on page 24 for more information.  

Use the Top Rows preview box to help you determine how many header rows 
to skip. When you enter the number of lines to skip, the corresponding rows in the 
Top Rows box will be removed from the file preview.  

Note:  The rows are NOT deleted from the pick list—they are ignored by the 
software when the protocol is run.  

 
Figure  3-21:  Specify lines to skip 
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e. Indicate if the pick list contains a header line (column headings). See “Data 
Contains a Header Line“ on page 25 for more information.  

f. Click the Import button to open the pick list in the Compound window below the 
file name. See Figure  3-22. If you need to edit the pick list, see “Edit window“ on 
page 53 for instructions.  

 
Figure  3-22:  Pick list in Compound window 

3. Import the control pick list (optional). 

a. Click the Controls tab in the Pick List window. 

b. Click the Import button in the Controls window.  

c. Browse to the folder that contains the control pick list and select the pick list you 
want to import. 

 If the pick list contains the column headings that the software recognizes (see 
“Pick List Header Data“ on page 23), the software displays the Import Control 
List window with the correct pick list format selected. Continue to step d. 

 If the pick list does not contain column headings, or the software does not 
recognize the headings, the software displays an error message. Click Yes to 
open the Import Control List window. 



 

Echo Cherry Pick User Manual  33 

d. In the Import Control List window, select the format that matches the pick list you 
are importing, if it is not already selected. 

 
Figure  3-23:  Select control pick list format 

The Import Control List window differs slightly from the Import Compound List 
window—the destination well location is always specified.  

 If the compound pick list uses the Explicit format (destination plate is 
specified), then the control pick list must also specify the destination plate. 

 If the compound pick list uses the Next Available Well format (destination 
plate is not specified), then the control pick list should not specify the 
destination plate. The software will add controls to every destination plate 
that is created to hold the compounds. 

e. In the Import Control List window, specify the number of lines to skip if the 
pick list contains other header data. See "Skip First Lines“ on page 24 for 
more information.  

Use the Top Rows preview box to help you determine how many header rows 
to skip. 

f. Specify the number of lines to skip if the pick list contains other header data.  

g. Indicate if the pick list contains a header line (column headings). 

h. Click the Import button to open the pick list in the Control text box. If you 
need to edit the pick list, see “Edit window“ on page 53 for instructions.  
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4. Preview the source and destination plates. 

a. Click the Plate Preview tab to display the layout for the source and destination 
plates. The color legend helps you identify the components on the plate maps. 
See Figure  3-24.  

The Plate Preview function is a useful tool for designing the layout of the 
destination plate. If you make changes to the protocol (for example, increase 
replicates or change processing order), the Plate Preview window will display 
those changes. 

b. Use the arrow keys to look at different source plates.  

 
Figure  3-24:  Plate Preview 

 

 

 



 

Echo Cherry Pick User Manual  35 

3.4 Run a Simulation 
Run a simulation to test the protocol before performing the actual liquid transfer. 
The simulation enables you to fix protocol or run errors before committing compounds 
and controls to the liquid transfer.  

To run a protocol simulation: 

1. Click the Run icon or select Run from the Protocol 
menu to open the Run Options window.   
 

 
Figure  3-25:  Run Options window 

 If you previously imported pick lists, this window will display the pick list file name 
and number of compounds or controls that were imported. 

 If you decide to import different pick lists, you can click the Reset button to 
remove the current pick list, and then click the Import Compound List button 
to import a different pick list. 

2. Click the Simulate button to open the Simulator window.  
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3. Click the Play button (lower right corner of the window) to start the simulator. 
During the simulation you have the option to skip the animation (to move quickly to 
the end) or cancel it. 

 
Figure  3-26:  Transfer Simulation 

For an in-depth discussion of the simulator program, see "Simulator window" on page 66. 
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3.5 Set up Plates 
1. Use the pick lists you created to assemble the source plates containing the compounds 

and controls you will be transferring.  

Note:  The compound and controls must be in Echo qualified source plates. 

 
Figure  3-27:  Assemble source plates 

2. Determine the number of destination plates that you will need. If you are not sure, 
refer to the destination plate data from the plate preview or simulated run.  

    
Figure  3-28:  Determine number of destination plates needed 

 

When your plates are ready for the transfer, continue to the next section to run the 
transfer protocol. 
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3.6 Run a Protocol 
After you have created a transfer protocol and tested it in the software simulator, you are 
ready to run the protocol on an Echo liquid handler: 

1. Click the Run icon or select Run from the Protocol  
menu to open the Run Options window. 

 

 
Figure  3-29:  Run Options window 

 

2. Connect to the Echo instrument, if you are not already connected.  

3. Import your pick list, if you did not import it previously or if you need to change the 
current selection.  
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4. Determine if you want to pre-process the pick list.  

 Select the Pre-process pick list option when you want the software to prompt 
you for the source plate in the order that is specified in the pick list. The software 
processes the plate barcode or ID data in the pick list at the beginning of the run, 
and then prompts you for the correct source plate during the run. The Barcode 
field is disabled. You can only select (or deselect) the Verify Barcode option.  

 
Figure  3-30:  Run Options window 

 Deselect the Pre-process pick list option when you want to control the source 
plate selection during the run. In the following screen, you can either select a 
plate from the drop-down menu or select Verify Barcode and insert the plate. 
The Echo instrument will automatically scan the barcode on the plate and insert 
the data in the Barcode field. 

 
The Pre-process pick list option is OFF (deselected) initially, then the last setting is 
retained. 
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5. Click the Run button to open the Run Status window.  

 
Figure  3-31:  Run Status Window 

6. Click the Start button to begin the transfer protocol.  

The software displays a prompt window to select the first source plate to be used in 
the transfer.  

 
Figure  3-32:  Plate Prompt 
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7. Follow the software prompts for each plate until the transfer is done.  

 
Figure  3-33:  Transfer Completed
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4 Software Reference 

This chapter contains descriptions of all the Echo Cherry Pick software screens. This 
information and procedures for each screen are available in the Echo Cherry Pick 
online Help.  

4.1 Toolbar ................................................................................................................43 
4.2 Protocol ...............................................................................................................44 

4.2.1 Source Plate Definition................................................................................44 
4.2.2 Destination Definition .................................................................................44 

4.3 Labware Definitions .............................................................................................46 
4.3.1 Plate Type List ............................................................................................46 
4.3.2 Plate Type Editor.........................................................................................48 
4.3.3 Plate Export................................................................................................51 
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4.4.1 Compounds and controls window ...............................................................52 
4.4.2 Plate Preview window.................................................................................54 
4.4.3 Import Compound and Control List windows...............................................55 

4.5 Protocol Options ..................................................................................................56 
4.5.1 Survey History.............................................................................................57 
4.5.2 Output Files................................................................................................59 
4.5.3 File Type.....................................................................................................59 

4.6 Preferences ..........................................................................................................64 
4.7 Run Protocol ........................................................................................................65 
4.8 Simulator window................................................................................................66 
4.9 Run Status window ..............................................................................................70 
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4.1 Toolbar  
The Toolbar contains the File, Protocol* Tools, and 
Help menus, as well as individual icons for frequently-
used functions.  

From the Toolbar, you can perform the following functions: 

File menu 
 Connect to instrument: Select an Echo 

instrument to connect to the software 

 New: Create a new transfer protocol 

 Open: Open an existing transfer protocol 

 Save:* Saves the current transfer protocol 

 Save As:* Copies the current transfer 
protocol to a different file name 

 Exit: Closes the Echo Cherry Pick software. 

Protocol menu* 
 Error Check: Checks the protocol for inconsistent 

information 

 Run: Executes the transfer protocol that is 
displayed. 

Tools menu 
 Preferences: Set survey, output, and report 

options for all protocols. 

 Labware definitions: Manage existing 
labware definitions or add new definitions. 

 Activate the instrument: Enter software 
license key to use the Echo Cherry Pick software on each Echo instrument. 

Help menu 
 Contents: View the Help table of contents. 

 Index: Search Help through available key words. 

 Search: Search Help through words or phrases. 

 About: Display the version number of the Echo Cherry Pick software. 

                                                   
* Available only when a protocol is open. 
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4.2 Protocol 
The Protocol window displays the following information: 

 
Figure  4-1:  Protocol window 

4.2.1 Source Plate Definition 
 Source Plate Type and Compound Volume.* Defines the source plate type used 

in the protocol and the compound volume. 
 Control Plate Type and Control Volume* (optional). Defines the source plate 

type used for controls in the protocol, the control volume, and the processing order of 
the controls: 

 At the end of the run to minimize swapping of the source plate. 
 At the end of each destination plate to minimize swapping of the 

destination plate. 

4.2.2 Destination Definition 
 Destination Plate Type. Defines the destination plate type and plate design for this 

protocol: 
 Next Available Well Mode: Defines the destination plate layout and fill direction 

for compounds and replicates 
 Number of Replicates:** number of copies of each compound (for example, 10 

replicates means that each compound in the source plate will be transferred to 10 
wells in the destination plate (Same Plate for all compounds that will fit on the 
plate or Different Plate for each compound and its replicates). 

                                                   
   * If this data is specified in the pick list, it will override the data specified in the protocol. 
** If the imported pick list is explicit, (contains destination plate data), the number of replicates must be set to 1. 

Source 
Definitions 

Destination 
Definition 



 

Echo Cherry Pick User Manual  45 

 Replicate Location:  defines how replicates are laid out on the destination 
plates: side-by-side (in adjacent wells option) or spread out over the plate. 

 
 

     
         

Figure  4-2:  Replicate location 

 Fill direction: direction that the compound will be transferred to the destination 
plate, either across the plate or down the plate. 

Note: The software determines the number of destination plates that are needed 
to hold all compounds and their replicates.  If a destination plate has insufficient 
wells to fill a compound and its replicates, then the compound and its replicates 
are moved to the next destination plate. The location of the resulting empty wells 
will depend on the fill direction (last column or row).  

 Destination Plate Design: plate template that allows you to block wells from 
receiving compound.  

 

Replicates for compound 1 in adjacent wells. Replicates for compound 1 staggered across plate.
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4.3 Labware Definitions 
The Echo Cherry Pick software relies on the labware 
definitions resident in the Echo liquid handler 
database. You can add new plate definitions or 
manage the existing ones by selecting Labware 
Definitions from the Tools menu. 

4.3.1 Plate Type List 
The Plate Type List window enables you to add new plate definitions or manage the 
existing ones.  

 
Figure  4-3:  Plate Type List 

Note: If you have received an error message followed by a blank Plate Type List, you will 
need to connect to an Echo liquid handler or import the labware file from the Echo liquid 
handler directory.  
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 Command Buttons: 
 Cache Plate List Locally. Click this button to save the plate list from the Echo liquid 

handler to the Echo Cherry Pick software.  

 Add a plate definition. Only a destination plate can be added. Refer to one of the 
following options: 

 Add a labware definition from the Echo Cherry Pick software 

 Add a plate definition from the Echo liquid handler software and reload the 
updated labware definition to the Echo Cherry Pick software. 

 Edit a plate definition. Select a plate definition and click the Edit button.  

 Source plate definition:  Only the barcode location of the source plate can be 
edited.  

 Destination plate definition:  Edit any setting in the definition. 

 Copy a plate definition. Select a plate definition and click the Copy button. You can 
copy a source or destination plate definition to create a destination plate definition. 

 Delete a plate definition. Select a plate definition and click the Delete button. You 
can delete a destination plate definition but not a source plate definition. 

 Import a single plate definition or group of definitions from a specific file location. 
The file must have an .elw extension to be imported.  

 Export a single plate definition or group of definitions. See "Plate Export“ on page 
51 for more information. 

 Reload the plate types that have been edited or deleted since the plate type list was 
last saved.   

 Save any changes you make to the plate type list, such as adding a new plate 
definition. 

 Close the Plate Type List window. 
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4.3.2 Plate Type Editor 
The Plate Type Editor window is similar to the Plate Specification window in the Echo 
liquid handler software. 

 
Figure  4-4:  Plate Type Editor 

Source plate definitions: Source plates require very exacting specifications and 
calibration to accurately transfer nanoliter volumes; therefore, they are defined specifically 
for the Echo liquid handlers and tested at Labcyte (Echo-qualified). For this reason, source 
plates cannot be defined by the user. For existing source plates, only the barcode location 
can be edited. Contact Labcyte to add more source plates. 

Destination plate definitions: The Echo liquid handler is programmed with several 
compatible destination plates; however, you can add destination plates through the Echo 
Cherry Pick software or the Echo liquid handler software.  

See online Help for procedures on adding, editing, or deleting labware. 
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 Fields: 
Name User-defined name to identify the plate. This name will be listed in the Plate Type List 

window  

Barcode Location Location of barcode label on the destination plate: 
None 
Left 
Right 
Long 

Manufacturer Name of the plate manufacturer 

Lot Number Lot number assigned by the plate manufacturer  

Part Number Part number assigned by the plate manufacturer  

Rows Number of rows in the microplate 

Columns Number of columns in the microplate 

Al X Offset (A)* Distance from left outside edge to center of first column where The 
left edge of the part will be defined as the two 12.7 mm areas (as 
measured from the corners) as specified in ANSI/SBS 1-2004 (internet 
link). Valid range: 0.0 to 128.0 mm. 

A1 Y Offset (B) Distance from top outside edge to center of first row where The top 
edge of the part will be defined as the two 12.7 mm areas (as 
measured from the corners) as specified in ANSI/SBS 1-2004 (internet 
link). Valid range: 0.0 to 86.0 mm. 

                                                   
* The items marked A-G are measurements that need to be taken by hand or filled in from the manufacturer's 

specifications. These dimensions and further details on their definitions can be found at 
http://www.sbsonline.com/msdc/approved.php. 
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X Center Spacing (C) Column spacing: Each following row/column shall be an additional 
X.Y mm in distance from the top/left outside edge of the plate as 
specified in ANSI/SBS 4-2004 (internet link). Valid range: 0.05 to 
9.0 mm. 

Y Center Spacing (D) Row spacing: Each following row/column shall be an additional X.Y 
mm in distance from the top/left outside edge of the plate as 
specified in ANSI/SBS 4-2004 (internet link). Valid range: 0.05 to 9.0 
mm. 

 

Plate Height (E) The overall height of the plate as specified in ANSI/SBS 2-2004 
(internet link). Valid range: 6.5 to 14.5 mm. 

Flange Height (F)** The height of the flange (skirt) as specified in ANSI/SBS 3-2004 
(internet link). Valid choices: 2.41 mm, 6.10 mm, and 7.62 mm. 
See Note 2 below. 

Well Width (G) The width of the well opening at the bottom (not an SBS specified 
dimension. Valid range: 0.0 to 86.0 mm. 

Well Capacity (H) The overall capacity of the well in microliters. Valid range: greater 
than 0.0 uL. 

 
 

 

                                                   
** Currently, the Echo liquid handler does not use dimensions F (flange height) and H (well capacity). Any value entered for 

flange height or well capacity is ignored. 
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4.3.3 Plate Export 
The Export Plates window displays the plates currently available in the Echo Cherry Pick 
software. You can select and export one or more plates to a file (.elw file extension) for 
use in another application.   

 
Figure  4-5:  Export Plates Window 

See online Help for procedure on exporting labware. 
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4.4 Pick List 
The Pick List window enables you to import and edit the compound and control pick lists, 
and preview the destination plate layout. This window contains the following windows: 

 Compounds:  to import and edit a compound pick list.  

 Controls:  to import and edit a control pick list. 

 Plate Preview:  to view the compounds and controls as they appear on the source 
plates, and to view the compounds and controls as they will appear on the destination 
plate, based on the pick list and the plate design in the protocol.  

4.4.1 Compounds and controls window 
The Compounds and Controls windows contain command buttons to import and manage 
compound and control pick lists. The window displays the pick list data in a table 
containing text fields that can be edited.  
 

 
Figure  4-6:  Compound pick list window 
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 Command buttons in Compound and Control windows: 
 Import: Opens a dialog box to find and select a pick list in .csv or .txt file format. 

Opens the Import Compound or Import Controls dialog box. See “Color Legend“ 
on page 54 for more information. 

 Reset: Removes the pick list from the protocol. 

 Save: Updates the original pick list with any changes you have made to the imported 
pick list. 

Note:  If you DO NOT want to change the original pick list, import a copy of the pick 
list. You will be prompted to save the edited pick list when you run the protocol. 
Although you do have the option to click No in the Save prompt box before the 
protocol run, it is safer to use a copy of the pick list. 

 File Name: Displays the directory location and file name of the imported pick list. 

 Edit window: Displays the pick list data. You can edit the pick list as follows:  

 Sort by heading. Click a column heading to sort by this heading. An arrow will 
appear to indicate the direction of the sort ( ascending; descending) 

 Edit a single value. Click or double-click the value and enter the new value. Use 
the scroll bars to view all columns and rows. Use the Tab key or arrow keys to 
move to the next field. 

 
Figure  4-7:  Edit pick list value 

 Select rows. Click any field in the table or click the cell to the left of the first 
data column to select a single row; click and drag the mouse pointer up or down 
to select consecutive rows; press the Control key and click any field in the desired 
rows to select non-consecutive rows. 

 Select All.  Click the Select All button at the bottom of the Edit window. 

 Unselect. Click the Unselect button at the bottom of the Edit window to unselect 
any previously selected rows.  

 Delete rows. Select the table rows to be deleted and click the Delete button at 
the bottom of the window.  

 
Figure  4-8:  Delete pick list row 
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4.4.2 Plate Preview window 
The Plate Preview window displays the plate layout of the source and destination plates.  

 
Figure  4-9:  Plate Preview window 

 Command buttons and Color Legend in Plate Preview: 
 Source Plate: Displays the plate layout for each source plate in the pick list. You 

can view different plates by selecting them from the Source Plate menu or clicking 
the left or right arrow   keys. 

 Destination Plate: Displays the destination plate layout that is specified either in the 
Protocol window or in the pick list. You can view different plates by selecting them 
from the Destination Plate menu or clicking the left or right arrow   keys. 

 Color Legend:  Defines the colored wells that are used in the plate layouts.  

 Pooled Well (green): More than one compound in the same well. 
 Compound (red):  Single compound in the well. 
 Control (blue):  Single control in the well. 
 Reserved:  Well blocked from compound transfer. This setting is ignored when 

the destination wells are explicitly called out. 
 Available: Empty well.  
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4.4.3 Import Compound and Control List windows 
The Import Compound (Control) List window contains all of the pick list formats that the 
Echo Cherry Pick software supports. 

 
Figure  4-10:  Import Compound list window 

For a discussion on pick lists, see "What is a Pick List?“ on page 4 and "Create Pick 
Lists“ on page 18. 

 Skip First Lines: Option to remove the header line and additional consecutive rows. 

 Data Contains a Header Line: Setting to indicate that the pick list begins with 
column headings. 

 Top Rows – Compounds List File:  Dynamic preview of top rows in the pick list. 
Removes the top row from the preview each time a line is skipped in the Skip First 
Lines field. 
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4.5 Protocol Options 
The Protocol/Options window is accessible by clicking the 
Options tab behind the Plate Design tab. This window enables 
you to customize the survey, output, and reporting options for 
the Echo Cherry Pick software. These settings are automatically 
used for any protocol you create.  

The Protocol/Options window displays the following protocol and output options.  

 
Figure  4-11:  Options Window 

Note: The options settings are similar to the Preferences/Options window, but apply only 
to the displayed protocol.  
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4.5.1 Survey History 
The Survey History function stores survey data for source plates. When the source plate is 
returned to the Echo liquid handler, the Echo Cherry Pick software recalls and uses the 
stored survey data instead of resurveying the plate.  

This feature can reduce processing time during a protocol run—particularly if the source 
plate is swapped several times during a protocol run. You can specify the length of time 
that the survey data is retained, from a few minutes to never resurvey.  

The software stores the survey data by plate barcode; therefore, the data is independent of 
the protocol and can be used repeatedly in different protocols until the expiration time.  

Note:  Various factors can affect the content of the source wells, such as DMSO 
concentration, humidity, and exposure time during the transfer run; therefore, consider 
these factors when you select an expiration time.  

For additional information, read the user note “How Long Will A Survey Last When 
Performing Acoustic Droplet Ejections?” on www.labcyte.com (Library>Resources>Notes) 
or use the link http://www.labcyte.com/Index.aspx?pageid=1000339.   

The Survey History function is located in the Options window: 

 
Figure  4-12:  Survey option 

http://www.labcyte.com/
http://email.labcyte.com/exchweb/bin/redir.asp?URL=http://www.labcyte.com/Index.aspx?pageid=1000339
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 Control Buttons: 
 Re-survey every source plate: Default setting that automatically surveys the 

source plate every time the protocol is run. 

 Maintain Survey History: Expiration button opens the Survey Data Expiration 
dialog box.  

 
Figure  4-13:  Survey Data Expiration 

 Control Buttons: 
 Never expires: Existing survey data is always re-used.  

 User-specified expiration time: Existing survey data is re-used for the time that is 
specified in minutes or days:hours:minutes.  

Notes:   

• If a stored survey does not cover the plate area that is required by the protocol (for 
example, some of the wells were empty when the plate was originally surveyed, but 
then filled later on), the software will survey the missing wells and add this data to the 
stored survey data.  

• The stored survey data is instrument-specific. For example, if a source plate is surveyed 
in instrument A, the stored survey data cannot be used in instrument B.  

• Although survey history can be used indefinitely, it is not recommended.  
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4.5.2 Output Files 
The Output Files box in the Options window organizes the survey and transfer results 
according to the following criteria: 

 
Figure  4-14:  Output Files options 

Run-specific: All protocol data is stored in one file, in the 
order that the results are generated. 

Plate-specific: Protocol data is stored in separate files, 
based on source or destination plates (depending on which 
process order you specified in the Plate Design window). 

 

4.5.3 File Type 
Survey and transfer results can be saved to the following file formats that are compatible 
with most laboratory information systems:  

 XML (extensible markup language) 

 CSV (comma separated values) 

 TXT (text file) 

The results will be saved in the formats you have checked, and stored in the directory you 
specify in the Directory option. 
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Report Format 

The survey and transfer reports can be customized by clicking the Format button in the 
Protocol Options window.  

Note:  The DEFAULT settings in the Transfer and Survey Reports are from the 
Preferences/Options window.  

 
Figure  4-15:  Report Format Options 
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The Output Format Builder window shows all the report variables (left selection box) that 
can be added to the report format (right selection boxes). The list of variables changes 
with the report area that you select.  

 

 
Figure  4-16:   Survey and Transfer Output Format Builder 
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Report Directory 

The default report directory for both surveys and transfers is C:\Labcyte\Echo\Reports. 
You can specify a different directory by clicking the Directory button and entering a new 
location. Use the Select Folder button to browse to a different directory. 

 
Figure  4-17:  Folder Name Window 

 

Report Filename 

The Echo Cherry Pick software uses the following default formats to report the survey and 
transfer results: 

Survey results file name: 
$AppName$\$RunDate$\$InstrSN$_$RunType$_$SrcPlateName$($SrcPlateBarcode$) 

For example:  Labcyte Echo Software\2007-Jan-09\E5XX-0690_Print_Plate1(1-989992-0) 

Transfer results file name:  
$AppName$\$RunDate$\$InstrSN$_$RunType$_$SessionID$ 

For example:  Labcyte Echo Software\2007-Jan-09\E5XX-0690_Print_123 
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The survey and transfer formats can be changed by clicking the Format button in the 
Protocol Options window.  

 

 
Figure  4-18:  Survey and Transfer Filename Builder 
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4.6 Preferences 
The Preferences/Options window is accessible from the 
Tools menu. This window is very similar to the 
Protocol Options window, but with the following 
differences: 

 Settings are automatically applied to all 
procedures unless you make changes in the Protocol Options window (report formats 
shown as “default”).  

 Accessible from the Toolbar.  

When you click Preferences, the Options window* opens to display the following 
protocol and output options: 

 
Figure  4-19:  Preferences/Options Window 

 



 

Echo Cherry Pick User Manual  65 

4.7 Run Protocol 
The Run Options window enables you to run a simulation of the transfer protocol or run 
the transfer protocol on the Echo instrument. If you are not connected to an Echo 
instrument, this window also provides a connection dialog box.  

 
In the Run Options window, you have the following options: 

 Connect to—or disconnect from—an Echo instrument  

 Import compound and control pick lists, if you did not import them earlier. 
(The Reset button removes the pick list from the protocol). 

 Pre-process pick lists in the order specified. Direct the software to use the pick 
list to determine the source plate order.  

 Simulate a transfer protocol.  

 Run a transfer protocol on the Echo instrument.  
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4.8 Simulator window 
The simulator is an animation of fluid transfer for the selected protocol. The simulation is 
interactive and allows you to respond to a prompt box to insert and remove plates. Since 
this is a simulation, the prompt box appears for only 5 seconds, then the software 
automatically responds to the prompt and continues to the next step.  

The protocol example that is described in this help page uses a pick list of compounds in 
five source plates and a control plate transferring to a single destination plate. The 
components of the simulator window are described below. 

 
 

The transfer animation (lower right corner of the window) 
simulates the movement of the destination plate (green) as it 
receives liquid from the source plate. Each source-to-
destination well transfer is documented below the plates.  

The following command buttons are available:  

Skip Animation:  stops a simulation in progress and shows 
the final view of the source and destination plates. 

Play:  begins the simulated compound transfer. 

Close:  closes the simulation window. If a simulation is in progress, you will need to 
cancel it before you can close the window.  
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The Source Plate Type map (upper left) shows the source plate that is selected for 
transfer. As the simulation runs, each source well shows the number of times the 
compound is aspirated. In this sample graphic the second source plate is in the process of 
being aspirated 5 times. The destination wells in red were transferred from the first source 
plate.  

 
 

The Destination Plate Type map (lower left) shows each well that receives a dispense 
and the number of dispenses that are received. In this sample graphic each compound is 
transferred to a destination well across a row. Since the protocol specified 5 replicates, the 
row is repeated 5 times. The red wells signify the compound transferred from the first 
source plate; the blue wells signify the compound being transferred from the second 
source plate.  
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The Well Color Legend (middle) shows the colors that 
correspond to the compound being transferred (red), 
controls (cyan), DMSO (yellow), reserved, or blocked from 
transfer (gray), and available (wells that have not been 
aspirated or dispensed). Dark blue wells represent wells 
that are in the middle of the transfer process. When the 
transfer is complete, the well changes to the color that 
matches the Well Color Legend.   

 

 

The sample graphic of a completed run shows the 6th source plate with controls and 
destination plate with compound and control. 
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The Protocol information box (upper right) provides details about the transfer protocol, 
such as the number of plates that will be needed. As the simulation proceeds, this box is 
updated to show which plates are currently in use.  
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4.9 Run Status window 
The Run Status window is a dynamic window that provides control buttons to run the 
protocol, and various status windows to show the progress of the compound transfer, 
the state of the Echo instrument, and the final well positions and volume of the 
transferred fluid.  

 
Control buttons:  Provides manual controls of the Echo instrument from the Echo Cherry 
Pick software.  

 

Source and Destination Plate windows:  Shows the status of each plate as it 
progresses through the transfer protocol. The Legend interprets the symbols used in the 
status windows.  
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Transfer Map window:  Shows the details of each well-to-well transfer. 

 
 

System Status window:  Shows the status of the Echo instrument during the 
transfer run. If a problem occurs, the alert will appear on this screen. 

 
 

Transfer Status:  Shows a progress bar of the transfer protocol, as well as percent 
completion and elapsed time. This section also provides a text window that displays all 
the actions that occur during the run. 
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 Control Status buttons 
 

Control Buttons Action 

 
Opens the process door of the connected Echo liquid handler. 

 
Extends the source plate gripper.  

 
Extend the destination plate gripper. 

 
Stops the transfer protocol that is in progress. 

 
Pauses the transfer protocol that is in progress. 

 
Continues the transfer protocol that is in progress. 

  
Begins the transfer protocol. 

 

 
Closes the Run Status window. 
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 Plate Prompt 
The Plate Prompt box instructs the user to insert or remove a plate. The plate prompt 
boxes are described below: 

Please insert source plate:  

 
1. Identify the source plate in one of the following ways: 

 Plate ID:  Select the source plate ID from the drop-down menu. 

 Barcode:  Skip the Barcode field and make sure the Verify Barcode option is 
selected. The Echo instrument will automatically scan the barcode label on the 
plate and insert it into the Barcode field.  

Note:  If you skip the Barcode field and forget to select Verify Barcode, the 
software will display a plate read error. 

 Pre-processed pick lists: Ensure that option in the Run Option window. If this 
option is selected, the Barcode field is initialized to display source plates listed in 
the pick list; therefore this field is not available for text changes (grayed out). 
However, you can disable the Verify Barcode option to bypass the barcode 
scan—particularly if you are using your own plate IDs instead of barcodes to 
identify the source plates.  

2. Insert the source plate into the source plate gripper stage and click OK in the software 
screen.  
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After the source plate is processed, the software removes it from the drop-down menu. 

Please remove source plate: Remove the source plate and click OK. 
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Please insert destination plate:  

 
 Select the source plate barcode (or plate ID) from the drop-down menu. If there is 

only one destination plate, the software will automatically select it and disable the 
verify barcode step. 

 Select Verify Barcode (optional) and click OK.  

After the destination plate is processed, the software removes it from the drop-down 
menu. 

Please remove destination plate: Remove the destination plate and click OK.  
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